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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1

Introduction
Enterprise Collaboration (EC) is a collaboration platform that enhances and facilitates the
collaboration that takes place in almost any flow in the IT organization using HP products. It does
this by connecting the structured datamanaged in applications in the IT workspace with the
unstructured collaboration that supports it.

This guide explains how to install and configure Enterprise Collaboration.

Enterprise Collaboration is installed and configured in the following stages:

1. " Install and Configure Enterprise Collaboration" (on page 10)

2. "Configure the User Repository and User Roles" (on page 24)

3. "Set Up Integration with Office Communicator Server andMS Lync Server" (on page 29)
Perform this procedure if you want to use EC with Office Communicator.

4. "Update Configuration in the Deployment Manager" (on page 55) Perform this procedure if you
want to make changes to database or OCS settings that were defined during the initial
installation, or to configure EC for Office Communicator Server (if you performed theOCS
integration setup in stage 3).

5. "Set Up the Adapter" (on page 59) Perform this procedure if you want EC to support
integrations with other applications, for example bringing context objects to conversations or
showing facets on an existing context object .

6. "Perform Additional Configuration Steps" (on page 53): Depending on your system setup, you
may need to perform additional configuration steps. Refer to this section if your systemmeets
one or more of the following criteria:

n Yourmail server is accessed using a secure connection and its certificate is self-signed

n Youwork with a standalone web application network configuration

n Youwork in a reverse proxy network configuration

n Youwant to disable redirection to https for authentication (for security reasons, this is not
recommended)

HP Enterprise Collaboration Documentation Library
HP Enterprise Collaboration includes the following guides and references available in PDF format.
For the latest copies of the HP Enterprise Collaboration documentation, go the HP Software
Manuals website: http://h20230.www2.hp.com/selfsolve/manuals. This site requires that you
register for an HP Passport and sign in.

Guide Description

HP Enterprise Collaboration
Installation and Configuration
Guide

Describes how to install and configure HP Enterprise
Collaboration.
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Chapter 1: Introduction

Guide Description

HP Enterprise Collaboration
Concepts Guide

Provides a detailed overview of HP Enterprise Collaborationi
concepts, components, and the conversation workflow.

HP Enterprise Collaboration
Integration Guide

Describes how to develop adapters for adding customized
application content and how to integrate Enterprise
Collaboration into third-party applications.

HP Enterprise Collaboration
Developers Guide

Describes how to integrate HP Enterprise Collaborationi into
individual customer applications.

HP Enterprise Collaboration
Release Notes

Provides last-minute news and information about
HP Enterprise Collaboration.

HP Enterprise Collaboration
Support Matrix

Details the HP EC system requirements and lists the HP
products and versions which currently comewith
HP Enterprise Collaboration.

HP Enterprise Collaboration
Open Sources and Third-Party
Software Agreements

Lists the licenses for open source and third-party components
included in HP Enterprise Collaboration.

In addition, you can access the HP Enterprise Collaborationmovie from the following location on
the DVD:

Documentation\Movies\HPEC_1.wmv
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Prerequisites
Before installing Enterprise Collaboration, Windows UAC (User Account Control) must be disabled.
If UAC is enabled, an error message will appear on the validation page during the installation
process.

To disable UAC:

1. From theStartmenu, select Run and typemsconfig.

2. In the System Configuration window, select the Tools tab.

3. From the Tools list, select Change UAC Settings and click Launch.

4. In the User Accounts Control window, scroll the bar toNever Notify and click OK.

Database and Tablespace Authorizations
A regular user (with special permissions) can install and configure the Enterprise Collaboration
database. There is no need for a DBA user.

When you create the installer user <username>, assign them the following permissions:

GRANT CREATE USER TO <username> WITH ADMIN OPTION;

GRANT CONNECT TO <username> WITH ADMIN OPTION;

GRANT UNLIMITED TABLESPACE TO <username> WITH ADMIN OPTION;

GRANT CREATE VIEW TO <username> WITH ADMIN OPTION;

GRANT RESOURCE TO <username> WITH ADMIN OPTION;

GRANT CREATE JOB TO <username> WITH ADMIN OPTION;

As the installation checks that the tablespace exists, the installer needs the following additional
permissions: 

GRANT SELECT ON DBA_TABLESPACES TO <username>;

Email Configuration
During the course of a conversation Enterprise Collaboration sends mails using the users email
addresses.

Not all mail servers allow this as theEmailGeneralFromName parameter is set to False by
default, preventing emails from being sent.

In this case, change the value of theEmailGeneralFromName parameter to Truemanually in the
JMX Console.
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Chapter 2

Install and Configure Enterprise Collaboration
This section contains detailed instructions on how to install and configure Enterprise Collaboration.
Before installing check that you have the correct prerequisites and authorizations as described in
Prerequisites and Database and Tablespace Authorizations.

Install Enterprise Collaboration
This section includes instructions for the initial installation of Enterprise Collaboration (EC). If you
have already installed EC and want to update the configuration, see the section "Update
Configuration in the Deployment Manager" (on page 55).

To install Enterprise Collaboration:

1. If you are downloading the EC installation .zip file from the HP website:Extract the
contents of the EC installation .zip file to any location that has access to all EC topology
entities (such as MSSQL or optional entities such as themail server or OCS) that EC
communicates with.

If you are installing from a DVD:Copy the entire contents of the DVD to a directory on your
hard drive.

2. Open the folderWindows_Setup and double-click EC.exe.

3. The Enterprise Collaboration Deployment Manager wizard opens.
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Read the license agreement. Select “I accept the terms of the license agreement”. Click Next.

4. The Deployment Type Selection page opens.

Select “Complete Deployment and Configuration”. Click Next.

5. The EC Deployment Host Details page opens.
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Select either “Deploy on the local machine” or “Deploy on the followingmachine”.

n If you choose “Deploy on the local machine”, the Deployment Folder Configuration page
opens.
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Use theBrowse button to select an installation folder or use the default path. Click Next.

Note: To check if the installation folder path is valid, click theValidate Availability
button. This checks if the folder path already exists and can prevent content override.
This check is optional, but recommended.

n If you choose “Deploy on the followingmachine”, enter details for the Remote Host location,
Host Username, and (optional) Host Password. Click Next.

Note:

n If you deploy on a Remote Host Location, you can click the Test Connection button at
this point to test the connection between your PC and the Remote Host Location. This
test is optional, but recommended.

n Once you have chosen amachine for deployment, from this stage on you can hover
over the server machine icon on each wizard page with themouse arrow to display
validation information (such as memory requirements, available ports, etc). If during the
configuration process you enter data that affects the validation (e.g. selecting a port
that is already in use on themachine), a red ‘X’ is displayed on the server machine, and
the pop-up shows the conflicted port.

6. The Network Configuration page opens.
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a. Select one of the following Network Environments:

o Stand AloneWeb Application

o HTTP/S Reverse Proxy Connection to aWeb Application

o AJP Reverse Proxy Connection to aWeb Application

Note: Formore information about the possible network environment configurations,
see the diagrams in "Appendix A: Network Configuration Schemas for HP Enterprise
Collaboration" (on page 67).

b. Click Next.

7. Depending on the network environment selected, one of the following pages opens:

n Stand Alone Application Configuration

n HTTP/S Reverse Proxy Configuration
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n AJP Reverse Proxy Configuration

a. If you want to allow only a secure connection to the web application even after the login
authentication stage, select Use a Secure Connection to connect to the Web
Application. By default, a secure connection is used for login authentication. After login
authentication, the client will continue with the same level of security it uses to access the
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web application.

To block incoming HTTP traffic to the web application additional firewall configuration is
required.

Note: Using a secure connection to connect to the web applicationmay affect
performance due to use of SSL for all connections.

b. Enter the following information in the relevant network configuration page:

o FQDN:Enter the FQDN of the web application or reverse proxy. If you are performing
the Stand Alone Application configuration, the default value is the FQDN of the
deployedmachine.

Note: After entering the FQDN, click Fill IP/Domain to make the wizard
automatically enter the IP Address and Domain Name.

o IP Address:Enter the IP address of the web application or reverse proxy. If you are
performing the Stand Alone Application configuration, the default value is the IP address
of the deployedmachine.

o Domain Name:Enter the Domain name of the web application or reverse proxy. If you
are performing the Stand Alone Application configuration, the default value is the
Domain name of the deployedmachine.

o HTTP Port (for Web Application): The default value is 8080.

o HTTPS Port (for Web Application): The default value is 8443 (this port is not relevant
for the AJP Reverse Proxy).

o HTTP Port (for Reverse Proxy ): The default value is 8080.

o HTTPS Port (for Reverse Proxy): The default value is 8443.

o AJP Port (non-secure connection): For AJP Reverse Proxy only. The default value is
8009.

o AJP Port (secure connection): For AJP Reverse Proxy only. The default value is
8109.

c. Click Next.

8. The Certificate page opens:

HP Enterprise Collaboration (1.1)Page 16 of 73



Installation and Configuration Guide
Chapter 2: Install and Configure Enterprise Collaboration

The certificate page is used to add a server certificate to EC in order to work with a secure
connection to the web application. If the customer wants to import their own certificate from an
existing keystore, they must enter the keystore path, keystore type, keystore password.

In the key alias field, they should enter the alias of the certificate they want to add to EC as it
appears in their own keystore.

In the key password field, they should enter the password of the certificate in the keystore. If
the certificate does not have a different password, the keystore password should be entered.

By default, EC generates a temporary self-signed certificate.

9. Click Next.

The Application Network Configuration page opens.
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Enter a value for JMS Port or use the default value of 61616. Click Next.

10. The Database Server Configuration page opens.

11. Select Oracle or MSSQL.

HP Enterprise Collaboration (1.1)Page 18 of 73



Installation and Configuration Guide
Chapter 2: Install and Configure Enterprise Collaboration

Configure the Oracle Database Administrator:

n Schema:

Select eitherConnect to an existing schema orCreate a new schema.

12. Enter the following information:

n Database Host Name/IP

n Port:A default value of 1521 is shown.

n SID/Service:System ID.

n Admin Username

n Admin Password

n Application Username:The name of the schema that the application uses to connect to
the database.

n Application User Password

n Confirm Password

n Default Tablespace: The tablespace of the schema. If the schema does not have a
tablespace, enterSystem in this field.
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13. Configure the MSSQL Database Administrator:

n Select eitherConnect to an existing schema orCreate a new schema.

n Enter the following information:

o Database Host Name/IP

o Port:A default value of 1433 appears.

Note: Supported database credentials are in SQL Authentication format.

o Database Username:Select a user namewith administrator permissions, including create
permission.

o Database Password

n Click the Test Connection button after entering the information above.

Note: If the test fails, youmust modify the information you entered on this page, or select
‘Skip Database configuration’.

n Database Name: If you selectedConnect to an existing schema, enter the name of the
database to connect to. If you selectedCreate a new schema, enter the name of the new
database.

14. Enter Application User Credentials:
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Application DB User: The name of the user used by the application to communicate with the
database.

Application DB Password: The password used by the application to communicate with the
database.

15. Click theValidate Application Access button.

Note: If this validation fails, youmust validate your user credentials.

16. Click Next.

17. The User Management Configuration page opens.

Note: If you skip database configuration, the User Management Configuration page is
automatically skipped.

a. Enter the following information:

o Temporary Administrator Login Name: This login name should not exist in your
existing user repository andmust not have been used in previous installations when
selecting "Connect to existing schema" in "Schema:" (on page 19).

o Temporary Administrator Password

o Confirm Password

b. Click Next.

18. The Lightweight Single Sign-On (LW-SSO) configuration page appears.
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Enter the LW-SSO Init String, confirm the string and click Next.

19. The Email Configuration page opens.
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The information on this page is divided into Sending Email and Receiving Email information.
For each type of email, fill in the following:

a. Protocol: Select a protocol to use to send/receive data. For sending data, use SMTP. For
receiving data, select either POP3 or IMAP4.

b. Hostname: The hostname of the incoming/outgoingmail server.

c. Port: The port number of the incoming/outgoing data.

d. Username: The EC mailbox username for receiving/sending emails.

e. Password: The password for the EC mailbox.

f. Encryption Type - Select the encryption to be used for the email server. If your protocol is
secured, select SSL or TLS according to the email server configuration:

o SSL: For SSL encryption, theSecure Port field is filled in automatically with the port
number and cannot be changed

o TLS - Trust Server. Enter the port numbermanually in theSecure Port field.

For each encryption type, select Approve to add the secure port.

These definitions are used for validating and installing certificates for EC to work against.

Optional: Test the Email configuration by clicking the “Validate” button after entering all the
configuration settings. After clicking this button, the EC installer checks if the Email server
uses a server certificate and if necessary automatically adds it to the EC keystore.

Click Next.

Note: All the information you enter in the Email Configuration page is optional. You can
skip this page by selecting “Skip”.

20. The Summary page opens.

In the Summary page, review all the information that you entered. If you want to change
anything, click theBack button to return to the page where you want to make the change. If all
the information is correct, click Next.

21. The Validation page opens.
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Validation occurs automatically when clickingNext in the Summary page.

n If all icons are green, validation is successful.

n If one or more icons are red, there is a problem with the configuration or you skipped the
database setup. You can choose to ignore the warning by selecting “Ignore warnings/errors
and continue”, or fix the problem and then click theRun Validation button in order to test if
the configuration problem has been fixed.

22. Click Deploy.

23. Wait for deployment to finish and click Finish.

After successful deployment, the following shortcuts appear in the Programs menu, under the
HP EC folder:

n Start HP EC

n Stop HP EC

n Uninstall HP EC

Configure the User Repository and User Roles
After completing the installation, youmust configure the user repository and user roles. Without
completing these steps, you will not be able to login to EC.

To configure the user repository and user roles:

1. Update the external-ldap.properties file located in the /conf directory, according to the
instructions in "Appendix B: Updating the external-ldap.properties File" (on page 68).
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2. Optional: If you are using LDAP over SSL, import your LDAP server certificate to the keystore
by executing the following batch file:

C:\HP\EC\diamond-deploy\set-ldap-certificate.bat <path_of_certificate_file>

3. In the bsf.properties file located in the \conf folder, set the following properties with the values
listed below and save the changes:

n authentication.provider=SHARED

n personalization.provider=SHARED

n users.provider=EXTERNAL

n groups.provider=EXTERNAL

n roles.provider=SHARED

n roles.relations.provider=SHARED

4. Start EC by going toStart > All Programs > HP EC > Start HP EC icon.

5. Open the User Management UI located at: http://<Server FQDN>:<port>/bsf

6. Log in using your temporary administrator user credentials as defined during the installation
process.

7. The User Management UI opens.

In the User Management section, find the relevant users and/or groups. For example, to find a
user click on the Search Users tab, enter the search details. Click theSearch button.

8. A list of users and/or groups matching the search details appears in the Roles and Permissions
section.
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Select the relevant user. Click on the Add Role icon ( ).

9. The Assign Roles dialog box opens.

Add the following roles to the user:
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n EC Admin: For permission to access EC, JMX, and User Management

n EC User: For permission to access EC

Note: It is important to give at least one EC Admin user access to the User
Management UI and the JMX.

10. Stop EC by going toProgram Menu > HP EC > Stop HP EC icon.

11. Update the bsf.properties file as follows:

n authentication.provider=EXTERNAL

n personalization.provider=SHARED

n users.provider=EXTERNAL

n groups.provider=EXTERNAL

n roles.provider=SHARED

n roles.relations.provider=SHARED

12. Restart EC by going toProgram Menu > HP EC > Start HP EC icon.

Configuration for Secure Login when Using Reverse Proxy
When using Secure Login (HTTPS) with Reverse Proxy, perform the following steps after the
installation has completed and before starting the server:

1. Open the bsf.war package using 7zip, WinRAR or any suitable extraction program to edit its
internal content.

2. Open the fileC:\HP\EC\servers\server-0\webapps\bsf.war\WEB-INF\applicationContext-
security.xml.

3. Update the forceHttps value to true as follows (marked in bold):

<bean id="authenticationProcessingFilterEntryPoint"
class="com.hp.sw.bto.security.springsecurity.
BSFAuthenticationProcessingFilterEntryPoint">

<property name="loginFormUrl">
<value>/login.form</value>

</property>

<property name="forceHttps">

<value>true</value>

</property>

</bean>

4. Update the fileC:\HP\EC\servers\server-0\webapps\diamond\WEB-
INF\classes\diamondlwssofmconf.xml by adding the lines in bold to the webui section:
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<nonsecureURLs>
<url>.*/images/.*</url>
<url>.*/desktopClient/.*</url>

</nonsecureURLs>

<reverseProxy enabled="true">

<full-
ServerURL>https://your.reverse.proxy.fqdn:8443/</fullServerURL>
</reverseProxy>

5. Validate that the authentication point is pointing at the reverseProxy. To do so, edit the file
C:\HP\EC\conf\client-config.properties and check themarked value (it should have the
reverseProxy FQDN).

bsf.server.url=https://your.reverse.proxy.fqdn:8443/bsf
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Set Up Integration with Office Communicator Server
and MS Lync Server

Enterprise Collaboration can integrate with the following versions of MS Communicator Servers: 

l Office Communicator Server 2007 (OCS)

l MS Lync 2010 Server

Install the Root Certificate Authority (CA) Certificate

Note: The instructions in this section are written for theMicrosoft CA Issuer. If you are using a
different issuing system, these instructions can serve as a basis for installing the Root CA
Certificate, but are not exact.

There are two stages in installing the Root CA Certificate, which are:

l "Check Which CA Is Used by the OCS" (on page 29)

l "Download and Install the Root CA Certificate" (on page 34)

If you already know the URL of the CA, you can skip the first stage and go directly to the second
stage.

Check Which CA Is Used by the OCS

To check which CA is used by the OCS:

1. Login to the OCS server and runmmc.exe.

2. The Console Root opens.
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In theConsole Root, go to File>Add/Remove Snap-in.

3. TheAdd/Remove Snap-In dialog opens.
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Select Certificates. Click Add.

4. TheAdd Standalone Snap-In dialog opens. Click Add.

5. TheCertificates snap-in dialog opens.
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Select Computer Account. Click Next

6. TheSelect Computer dialog opens.

Select Local Computer. Click Finish.

7. TheAdd Standalone Snap-In dialog opens again. Click Close.

8. TheAdd/Remove Snap-In dialog opens again. Click OK.

9. TheConsole Root opens again.

Go toPersonal>Certificates (see below) to see the Root CA certificate and the CA that
issued it.
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10. Go to theDetails tab.
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11. Use the Authority Name in the URL line to download the Root CA certificate in the next step.
The Authority Name appears in the URL from the '=' to the first single '/'. For example, in the
image above the Authority name is http://adtestdc1.test.net.

Download and Install the Root CA Certificate

To download and install the Root CA certificate:

1. Login to the OCS agent machine.

2. Browse to the Certificate Authority web server with the Certificate's Authority Name from the
URL you received above in theDetails tab. Youmust use the Authority Name and append to it
/certsrv. For example, in the Details tab above, the Authority Name is
http://adtestdc1.test.net.. Therefore, you would browse to the Certificate Authority web server
with the URL http://adtestdc1.test.net/certsrv.

3. TheWelcome page opens.

In theWelcome page, click Download a CA certificate, certificate chain, or CRL.

4. The following page opens.
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Click Download CA certificate chain.

5. A File Download prompt opens, asking if you want to save the Root CA Certificate (*.p7b file).

Save the Root CA certificate anywhere on the file system.

6. Runmmc.exe.

7. In theConsole Root, go to File>Add/Remove Snap-in.

8. In theAdd/Remove Snap-Inwindow, click Add.

9. In theAdd Standalone Snap-Inwindow, select Certificates from the list. Click Add.

10. In theCertificates snap-inwindow, select Computer Account. Click Next.

11. In theSelect Computerwindow, select Local Computer. Click Finish.

12. In theAdd Standalone Snap-Inwindow, click Close.

13. In theAdd/Remove Snap-Inwindow, click OK.

The Certificate Import Wizard is launched.
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14. Click Next in the wizard.

15. In theCertificate Storewindow, select Place all certificates in the following store (see
below). Click Next.

16. When the wizard finishes, go to theConsole Root and right-click on the Trusted Root
Certification Authorities folder.
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17. A pop-upmenu opens.

Go toAll Tasks > Import to import the Root CA certificate.

Install the Server Certificate on the OCS Agent Machine
To issue the Server Certificate and install it on the OCS agent machine:

1. From theOCS agent machine (important), browse to the CA web site with the Certificate's
Authority Name. Youmust use the Authority Name and append to it /certsrv. For example, if
the Authority Name is http://adtestdc1.test.net., you would browse to the Certificate Authority
web server with the URL http://adtestdc1.test.net/certsrv.

2. A Welcome screen opens. Select Request a certificate.
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3. TheRequest a Certificate screen opens.

Select advanced certificate request.

4. TheAdvanced Certificate Request screen opens.
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Select Create and submit a request to this CA.

5. TheAdvanced Certificate Request form opens.
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Fill in the form. Note that the “Mark keys as exportable” check box may appear disabled. If you
browsed from theOCS agent machine this check box does not need to be enabled.

6. Click theSubmit button when you are finished filling out the form.

n If your Certificate Authority Service is configured to automatically issue the certificate, the
Certificate Issued screen appears (see below). Click Install this certificate and continue
to the next step.
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n If your Certificate Authority Service is not configured to automatically issue the certificate,
youmust ask your CA Administrator to issue the specific certificate request. In this case,
instead of theCertificate Issued screen above, aCertificate Pending screen appears.

i. After you get amessage that the certificate was issued, browse to the CA web site
with the Certificate's Authority Name from theOCS agent machine (important) as you
did in Step 1.

ii. In theWelcome screen that appears, click View the status of a pending certificate
request.
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iii. The following screen opens. Select the issued certificate.

iv. TheCertificate Issued screen appears. Select Install this certificate.

7. Verify that you get the followingmessage.

8. Login to the OCS server and runmmc.exe.

9. The Console Root opens. Go to File>Add/Remove Snap-in.

10. TheAdd/Remove Snap-In dialog opens. Select Certificates. Click Add.
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11. TheAdd Standalone Snap-In dialog opens. Click Add.

12. TheCertificates snap-in dialog opens. SelectMy user account (see below) to add theUser
account Certificates Snap-In. Click Finish.

13. If you need to run the OCS agent process from different user accounts, drag the issued
certificate from
Certificates - Current User>Personal>Certificates (shown in the first image below) to the
Certificates (Local Computer)/Personal/Certificates (shown in the second image below).
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Agent Provisioning
This section describes how to set up Agent Provisioning for Office Communicator Server 2007 and
Lync Server 2010.

Agent Provisioning for OCS 2007
Prerequisites

l TheOCS Server port should be open for communication from OCS agent machine.

l The domain user performing OCS agent setup should be amember of the
RTCUniversalServerAdmins group and amember of the Local/Administrators group on theOCS
agent machine.

To set up agent provisioning for Office Communicator Server 2007:

1. Login to the OCS agent machine as a user who is amember of the
RTCUniversalServerAdmins group.

2. Double-click theMicrosoft utility ApplicationProvisioner.exe in the folder ocs-agent
(deployed as part of Enterprise Collaboration).

3. TheApplication Provisioner dialog box opens.
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ForApplication Name, enterHPEC. Click Find or Create…

4. TheCreate Application Pool dialog box opens.

a. Enter the following information:

o Choose the FQDN of your OCS server from theOCS Pool Fqdn: drop-down list.

o Enter a value for the Listening port, or use the default value.

o Select the Localhost check box.

b. Click OK.

5. TheApplication Provisioner dialog box opens.

Create a Contact object by clickingAdd… under the Contacts section.

6. TheCreate Contact dialog box opens.
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a. Enter the following Contact information:

o Contact Uri:Enter here the SIP address of the HPEC OCS agent. The format is
sip:<name>@<domain name>. For example, sip:HPEC@hp.com.

Note: The <name> in the Contact Uri should be a user that exists in the active
directory, with email andOCS permissions.

o Display name: The name you enter here will be the name that OC users see as the
sender display namewhen receiving OC messages from EC. For example, HPEC.

Note: Phone Uri should remain empty, and the two checkboxes in the dialog box
should be unchecked.

b. Click OK.

7. In theApplication Provisioner, select the Contact. Click View… under the Servers section.

8. TheView Server dialog box opens.
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In theView Server dialog box, save the GRUU for further configuration of the OCS agent.

Agent Provisioning for Lync 2010
1. On the Lync Server machine, run:

Start > Microsoft Lync Server 2010 > Lync Server Management
Shell

2. Create a trusted application by running the following command:

New-CsTrustedApplication -ApplicationId <application-id> -Port
<application-port> -TrustedApplicationPoolFqdn <ocs-agent-fqdn>

For example:

New-CsTrustedApplication -ApplicationId EeApplicationId -Port 6000
-TrustedApplicationPoolFqdn exum.fabrikam.com

No errors should occur:

3. Save the ServiceGruu value for further configuration of the OCS agent.

4. Enable topology by running the following command:

Enable-CsTopology

5. Create trusted application endpoint by running the following command:

New-CsTrustedApplicationEndpoint -SipAddress <app-sip>
-DisplayName <app-display-name> -TrustedApplicationPoolFqdn <ocs-
agent-fqdn> -ApplicationId <app-id>

For example:

New-CsTrustedApplicationEndpoint -SipAddress sip:ee@fabrikam.com -
DisplayName EE
-TrustedApplicationPoolFqdn exum.fabrikam.com -ApplicationId
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EeApplicationId

OCS Setup to Support Rich Content

Note: OCS setup to support Rich Content is optional. If you have already setup the OCS to
support Rich Content, or you do not need Rich Content support, you can skip this section.

To setup OCS to support Rich Content:

1. Copy the fileCommunicator.adm that is located in the folder where you installed Enterprise
Collaboration to the OCS machine.

2. Run gpedit.msc as follows:

a. Go toComputer Configuration. Right-click Administrative Templates and choose
Add/Remove Templates…

b. In the dialog, click Add… and specify the path where the Communicator .adm file is
located.

c. Go toComputer Configuration>Administrative Templates>Microsoft Office
Communicator Policy Settings>Microsoft Office Communicator Feature Policies.

d. Change the setting of Prevent rich text in instant messages toDisabled, and the setting
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of Allow hyperlinks in instant messages toEnabled, as shown below.

3. Run theMicrosoft Management Console by runningC:\Program Files\Common
Files\Microsoft Office Communications Server 2007 R2\WRTCSnap2.msc.

a. Go to Forest - …>Standard Edition Servers and right-click the poll with the OCS server
host name.

b. From the pop-upmenu, choose Filtering Tools>Intelligent Instant Message Filter, as
shown below.
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c. In theURL Filter tab, clear theEnable URL filtering check box, as shown below.

d. In the File Transfer Filter tab, clear theEnable file transfer filtering check box, as
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shown below.

4. Restart the OCS server machine.

OC Client Setup to Support Rich Content

Note: OC client setup to support Rich Content is optional. If you have already setup the OC
client to support Rich Content, or you do not need Rich Content support, you can skip this
section.

1. Copy the fileOCSClient.reg that is located in the folder where you installed Enterprise
Collaboration to themachine where the OC client is installed.

2. On the client machine (where the OC client is installed), run the fileOCSClient.reg and restart
the OC client application.

Sanity Testing of EC and OCS Integration
1. Start the HP EC server on the server machine.

2. Start the OCS agent on the server machine.

3. Start the OC client on the client machine. Login as user2.

4. Start the browser, go to the HP EC site. Login as user1.
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5. Create a new conversation. Add user2 to the conversation.

6. Mark user2 as required (urgent) in the conversation. User2 should receive notification in the OC
client.

7. Send a reply from OC client. The reply from user2 should be added to the conversation.
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Perform Additional Configuration Steps
This section presents twomanual processes that should be used if the automatic process during
the installation has failed.

Install a Certificate for the Mail Client
There are two ways to install a certificate for themail client. This installation is required if themail
server is accessed using a secure connection and its certificate is self-signed.

Method 1

1. Complete the EC installation providing Email configuration data, but without running Email
configuration validation.

2. Discover with IT which ports of the email server are secure.

3. On the EC server, run diamond-deploy/add-email-certificates.batwith the following
parameters:
add-email-certificates.bat <email-sending-host>:<email-sending-secure-port>
<email-receiving-host>:<email-receiving-secure-port>

For example:

add-email-certificates.bat exch14.net:466 exch14.net:996

4. Restart the EC server.

Method 2

1. Verify that EC is not running.

2. Open CMD.

3. Run the following command to import your certificate:

<EC FOLDER>\java\windows\x86_64\bin\keytool.exe -import -alias <YOUR
CERTIFICATE ALIAS> -file <ROOT CA CERTIFICATE PATH> -keystore <EC
FOLDER>\java\windows\x86_64\lib\security\cacerts

Install Customer Certificates
At the end of the installation process, the Tomcat server is set with a self-signed temporary
certificate.

If you work with a standalone web application network configuration, you can work with the self-
signed certificate generated during the EC installation without performing the steps below.
However, it is recommended to import your Server Certificate to the keystore as described below.

If you work in a reverse proxy network configuration, you should import your Root CA certificate
and Server Certificate to the EC server keystore by performing the steps below.

To install a certificate for Tomcat:
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1. Verify that EC is not running.

2. Open CMD.

3. Run the following command to delete the temp certificate from keystore:

<EC FOLDER>\java\windows\x86_64\bin\keytool.exe -delete -alias tomcat -keystore
<EC FOLDER>\servers\server-0\ec-keystore.jks

4. Perform one of the following commands:

n To import your keystore to the EC keystore:

<EC FOLDER>\java\windows\x86_64\bin\keytool.exe -importkeystore -srckeystore
<YOUR KEYSTORE PATH> -destkeystore <EC FOLDER>\servers\server-0\ec-
keystore.jks -srcstoretype <YOUR KEYSTORE TYPE>

n To import your certificate to the EC keystore:

<EC FOLDER>\java\windows\x86_64\bin\keytool.exe -import -alias <YOUR
CERTIFICATE ALIAS> -file <YOUR CERTIFICATE PATH> -keystore <EC
FOLDER>\servers\server-0\ec-keystore.jks

Note: For reverse proxy certificates, this command should be performed for both Root
CA and Server Certificates.

Disabling Default Secure Authentication (optional)
Perform this step only if you want to disable redirection to https for authentication.

Note: For security reasons, this is not recommended.

1. Verify that EC is not running.

2. Open CMD.

3. RunC:\HP\EC\diamond-deploy\disable-secure-authentication.bat.

4. Start EC.
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Update Configuration in the Deployment Manager
You can update the configuration from theDeployment Type tab of the Deployment Manager.

1. In the EC-Deployment Manager folder, double-click EC.exe.

2. The Enterprise Collaboration Deployment Manager wizard opens.

In theWelcome page, check “I accept the terms of the license agreement”. Click Next.

3. The Deployment Selection page opens.

Select Update Configuration of Deployed Machine.

4. Additional options appear for selecting the type of configuration update.

The configuration options are:

n Database Configuration: If you choose this configuration, the update wizard takes you
through the following pages:

o EC Deployment Host Details

o Deployment Folder Configuration

o MSSQLDatabase Server Configuration

o UserManagement Configuration
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o Summary

o Validation

n Communication Channels Configuration: This configuration should be performed only if
you intend to use Enterprise Collaboration with Office Communicator and only after you
have performed theOffice Communicator Setup as described in "Set Up Integration with
Office Communicator Server andMS Lync Server" (on page 29).

n Upload Custom Certificate: Select this configuration to upload a customized security
certificate at the end of the installation. See Step 8 for details.

It is possible to select all configuration options.

5. Choose the type of configuration update you want to perform. Click Next.

6. If you choseDatabase Configuration in the previous step, the configuration wizard takes you
through the pages mentioned in step 4 and you canmodify settings in these pages according to
your needs.

If you choseCommunication Channels Configuration in the previous step, the
configuration wizard takes you through the pages EC Deployment Host Details, Deployment
Folder Configuration, and Communication Channels Configuration. EC Deployment Host
Details and Deployment Folder Configuration were already presented during installation and
you canmodify settings in these pages according to your needs.

The Communication Channels Configuration page is shown below.
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7. In the Communication Channels Configuration page, enter the following information:

n OCS Server FQDN: Enter here theOCS Pool Fqdn that you entered during the "Set Up
Integration with Office Communicator Server andMS Lync Server" (on page 29) process.

n OCS Server Port: The default value is 5061. Consult your system administrator for this port
number.

n OCS Application Name: The default name is EE. Enter here theDisplay Name that you
entered during the "Set Up Integration with Office Communicator Server andMS Lync
Server" (on page 29) process.

n OCS Application Port: The default value is 6000. Enter here the Listening Port number
that you entered during the "Set Up Integration with Office Communicator Server and
MS Lync Server" (on page 29) process.

n OCS Application GRUU:Enter here the string that you obtained during the "Set Up
Integration with Office Communicator Server andMS Lync Server" (on page 29) process.

n OCS Application SIP URI: The default value is sip:EE@. Enter here theContact Uri that
you entered during the "Set Up Integration with Office Communicator Server andMS Lync
Server" (on page 29) process.

n OCS Agent FQDN: This value should be the FQDN of the EE server.
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8. If you chooseUpload Custom Certificate, select toUse temporary certificate or to use a
customized certificateUse custom certificate.

9. If you select Use custom certificate, enter the keystore details in the relevant fields.

Two types of keystores supported.- JKS andPKC.

The certificate is imported according to the Key alias entered.
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Set Up the Adapter
1. Download the adapter .war file from: www.hp.com/go/livenetwork

2. Put the adapter .war file in the directory <EC_Installation_Folder>/servers/server-
0/webapps. The name of the adapter .war file should be the same as the adapter name.

If you want to deploy the adapter remotely, you can use the Tomcat manager application to do
this, according to the following instructions:
http://tomcat.apache.org/tomcat-7.0-doc/manager-howto.html

Note: In order to prevent network speed issues, copy the adapterwar file to the
temporary directory in the target server. Then after the deployment, move it from the
temporary directory to the directory
<EC_Installation_Folder>/servers/server-0/webapps.

3. Add the basic adapter URL using JMX as follows:

a. Go to <EC_application_url>/diamond/jmx-console (for example, http://my_
host:8080/diamond/jmx-console).

b. Select Diamond > Diamond adapter config jmx service.

c. In themethod addAdapterUrl (see the figure below) add the following parameters:

o adapterName: This name should be identical to the adapter.war filename. For
example, if the filename is sm.war, enter sm here.

o adapterUrl: For local deployment, the adapter URL should be {local}/adapter_name.

d. Click Invoke.

4. If your adapter uses LWSSO, check that the initString defined in the LWSSO configuration
file in adapter .war is the same value that you defined for initString in the Lightweight Single
Sign On configuration page during the EC installation.
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Upgrade EC Configuration from 1.0 to 1.1
This section describes how to upgrade Enterprise Collaboration from version 1.0 to version 1.1.

If you have a previous version of Enterprise Collaboration installed and need to use the same data
in the EC 1.1 installation, before upgrading, perform the following steps:

Note: EC 1.1must be installed on themachine on which the previous EC version was
installed.

1. Backup the external-ldap.properties and ldap certificate file (if they exist) from the previous
installation to a temporary directory.

2. Backup all existing adapters from C:\HP\EC\servers\server-0\webapps to temp directory.

3. Backup the database schema.

4. Uninstall EC (1.00 or 1.01), so the EC service and all shortcuts will be removed.

Next, install Enterprise Collaboration 1.1:

1. Install EC 1.1 as described in Install Enterprise Collaboration using theConnect to Existing
Schema option (See "Configure theMSSQLDatabase Administrator:" (on page 20)).

2. During installation, enter all the configuration details as in the previous installation (init-string,
email, OCS).

Note: The temporary administrator that you add at this stagemust be different from the
previous temporary administrator andmust not exist in the user repository.

3. After the installation has completed successfully, copy the external-ldap.properties file from
theC:\temp directory toC:\HP\EC\conf (overwriting the existing file).

4. Place the backup ldap certificate (if one exists) in diamond-deploy and then run:

set-ldap-certificate.bat certificate-file-name

5. Update bsf.properties to:

   authentication.provider=EXTERNAL

personalization.provider=SHARED

users.provider=EXTERNAL

groups.provider=EXTERNAL

roles.provider=SHARED

roles.relations.provider=SHARED

6. Move the backup adapters from the temp directory into C:\HP\EC\servers\server-0\webapps

7. Start the EC server.

HP Enterprise Collaboration (1.1)Page 60 of 73



Installation and Configuration Guide
Chapter 7: Upgrade EC Configuration from 1.0 to 1.1

8. To allow all existing conversations to be reindexed for searches, reset the elastic search as
follows:

a. Go to http://diamond_host:<http_port>/diamond/jmx-console.

b. Login with the administrator user (temporary administrator user created in the User
Management Configuration page during the installation of version 1.1).

c. Select Diamond > Diamond search JMX service.

d. Invoke the resetExperienceLastIndexRunTimemethod.

Note: After completing the Upgrade procedure, there is no need to enter BSF user
management as all the role definitions already exist in the database.
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Desktop Client Installation
The Desktop Client application is an additional tool for viewing notifications about changes made in
EC conversations. It provides information about current conversations in Enterprise Collaboration
in which you are a participant.

This task explains how to install the Desktop Client on your system and provides a detailed
description of the Installation wizard steps.

To install the Enterprise Collaboration Desktop Client from within Enterprise Collaboration:

1. Click on the user name in the upper right corner of the EC window:

2. The User Profile window opens:

3. Click on theDownload Desktop Client link at the bottom of the window.

4. If the Open File warning window opens, click Run in this window.

5. Select Save or Open to download and extract the Desktop Client zip file.
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6. Then run hpec_dc.exe.

7. The HP EC Desktop Client Installation begins.

8. In the Introduction dialog box, click Next.

9. In theChoose Install Folder dialog box, click Choose to browse to the installation folder and
then click Next.
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10. In theChoose server host and port dialog box, enter the EC Server host name and port
number and click Next.

11. In theWhen to Start dialog box, select Start the application when you log on to Windows
to automatically run the EC Desktop Client each time you log in toWindows. Select Start the
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application after installation to run the EC Desktop Client immediately after the installation
procedure.

12. A summary of the installation details is presented. Review the summary and then click Install.

13. Click Done. The HP EC Desktop Client Settings window opens.
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14. In the Password field, type in the user's password and then click OK.

15. The Desktop Client begins running and is shownminimized on the status bar.

16. If you did not select Start the application after installation in theWhen to Start dialog box
you can run the Desktop Client at any time by selectingStart > All Programs
> HP EC Desktop Client.

For details on using the EC Desktop Client, see the Enterprise Collaboration Concepts Guide.
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Appendix A: Network Configuration Schemas for HP
Enterprise Collaboration

The following diagrams show the possible network configuration schemas for HP Enterprise
Collaboration.
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Appendix B: Updating the external-ldap.properties
File

Beforemaking changes in the external-ldap.properties file, you should be familiar with the
relevant LDAP properties required for your User Repository. If you are unfamiliar with the LDAP
configuration, you can use tools such as the Apache Directory Studio LDAP browser in order to
detect the relevant LDAP properties required for your User Repository. For instructions on how to
login to LDAP using the Apache Directory Studio LDAP Browser, see "Logging into LDAP using the
Apache Directory Studio LDAP Browser" (on page 73) .

Basic LDAP Properties
The following table lists the basic LDAP properties that you need to configure in external-
ldap.properties in order for EC to logon to LDAP.

Attribute Description

ldapHost LDAP host name

ldapPort LDAP port number

enableSSL True/False—use SSL connection to LDAP

useAdministrator True/False—use this user to connect to LDAP

ldapAdministrator LDAP user DN

(defined if useAdministrator=True)

ldapAdministratorPassword LDAP user password

(defined if useAdministrator=True)

Note: The password for the LDAP user is not encrypted in the
external-ldap.properties file.

Configure the User Providers
Update the external-ldap.properties file with the following attributes according to the customer’s
organizational LDAP properties.

Attribute Description

usersBase LDAP Base Distinguished Name (DN) for the users search. Only users under this
DN in the LDAP hierarchy are returned from the search.

usersScope LDAP search scope for users search. Defines how exactly the search under the
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Attribute Description

usersBase location should be performed. SCOPE_BASE search space contains a
single entry pointed by the userBase; SCOPE_ONE - search space contains the
userBase and its direct children only; SCOPE_SUB - search space contains the
userBase and its whole sub tree.

usersFilter LDAP filter for users search

Configuring Users Object Class
The following properties are used to define the LDAP vendor or customized implementation-specific
objects that represent the user objects.

Tomap the user configuration properties to the LDAP server configuration properties of the
organization, update the external-ldap.properties file with following attributes according to the
organization’s LDAP properties.

Attribute Description

usersObjectClass LDAP object class representing the user’s object.

usersUniqueIDAttribute The user’s unique ID LDAP attribute name.

usersLoginNameAttribute The user’s login name LDAP attribute name.
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The following attributes are optional:

Attribute Description

usersDisplayNameAttribute Users display name LDAP attribute name.

usersFirstNameAttribute Users first name LDAP attribute name.

usersLastNameAttribute Users last name LDAP attribute name.

usersEmailAttribute Users email LDAP attribute name.

usersSipAttribute Users SIP LDAP attribute name.

usersPreferredLanguageAttribute Users preferred language LDAP attribute name.

usersPreferredLocationAttribute Users preferred location LDAP attribute name.

usersTimeZoneAttribute Users time zone LDAP attribute name.

usersDateFormatAttribute Users date format LDAP attribute name.

usersNumberFormatAttribute Users number format LDAP attribute name.

usersWorkWeekAttribute Users work week LDAP attribute name.

usersTenantIDAttribute Users tenant ID LDAP attribute name.

usersPasswordAttribute Users password LDAP attribute name.

Groups Search
The following properties define the searchmechanism that is implemented on LDAP groups. There
are two sets of properties, one for regular groups and one for root groups.

In order to display only a limited number of groups, restrict the root groups search criteria
appropriately. The same search criteria for both root and non-root groups can be used. This
configuration is recommended when the overall number of groups is small.

Tomap the groups configuration properties to the LDAP server configuration properties, update the
external-ldap.properties file with the following attributes according to the organization's LDAP.

Attribute Description

groupsBase LDAP Base Distinguished Name (DN) for groups search. Only groups under
this DN in the LDAP hierarchy are returned from the search.

groupsScope LDAP scope for groups search.

l SCOPE_BASE search space contains a single entry pointed to the
groupsBase;

l SCOPE_ONE - search space contains the groupsBase and its direct
children;

l SCOPE_SUB - search space contains the groupsBase and its whole sub
tree
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Attribute Description

groupsFilter LDAP filter for groups search. The only valid values are rootGroupsBase,
rootGroupsScope, or rootGroupsFilter.

rootGroupsBase LDAP Base Distinguished Name (DN) for groups search. Only groups under
this DN in LDAP hierarchy are returned from the search.

rootGroupsScope LDAP search scope for groups search. Specifies how the search under the
gropusBase location should be performed.

l SCOPE_BASE - search space contains a single entry pointed to the
rootGroupsBase;

l SCOPE_ONE - search space contains the rootGroupsBase and its direct
children only;

l SCOPE_SUB - search space contains the rootGroupsBase and its whole
sub tree

rootGroupsFilter LDAP filter for groups search

Groups Object Class (LDAP Vendor Dependent)
The following properties are used to define the LDAP vendor or custom implementation-specific
objects representing static groups. More than one comma-separated object class is supported. In
this scenario, the user can define the appropriate corresponding comma-separated attribute names.

Tomap the groups configuration properties to the LDAP server configuration properties, update the
external-ldap.properties file with the following attributes according to the organization's LDAP
properties.

Attribute Description

groupsObjectClass LDAP object class representing group object.

groupsMembersAttribute Groups members LDAP attribute name. This multi-value attribute
contains the full distinguished names (DNs) of static groupmembers.

The following attributes are optional:

Attribute Description

groupsNameAttribute Groups unique name LDAP attribute name. In most
default LDAP implementations, this attribute is usually
the same as groupsDisplayNameAttribute.

groupsDisplayNameAttribute Groups display name LDAP attribute name. In most
default LDAP implementations, this attribute is usually
the same as groupsNameAttribute.

groupsDescriptionAttribute Groups description LDAP attribute name. The attribute
contains the groups’ description.
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Attribute Description

enableDynamicGroups Boolean attribute for enabling dynamic groups. If the
value of this attribute is true, dynamic groups are
searched. Note that enumeratingmembers of very large
dynamic groups may be time consuming.

dynamicGroupsClass LDAP object class representing dynamic group object.

dynamicGroupsMemberAttribute Dynamic groups members LDAP attribute name. This
attribute contains the LDAP search URL. The values
returned by this LDAP search URL are considered
dynamic groupmembers.

dynamicGroupsNameAttribute Dynamic groups unique name LDAP attribute name. In
most default LDAP implementations, this attribute is
usually the same as
dynamicGroupsDisplayNameAttribute.

dynamicGroupsDisplayNameAttribute Dynamic groups display name LDAP attribute name. In
most default LDAP implementations, this attribute is
usually the same as dynamicGroupsNameAttribute.

dynamicGroupsDescriptionAttribute Dynamic groups description LDAP attribute name. This
attribute contains the groups description.

Groups Hierarchy
TheGroups Hierarchy attributes defines whether HP Enterprise Collaboration relates to LDAP
server groups hierarchy information.

Attribute Description

enableNestedGroups Enable support of nested groups. If support of nested
groups is disabled, subgroups of a group are not
searched.

maximalAllowedGroupsHierarchyDepth Maximal allowed depth of groups hierarchy. No groups
are searched beneath this level.

Advanced Configuration
The advanced configuration attributes are used for fine-tuning the LDAP connection.

Attribute Description

ldapVersion LDAP protocol version. Possible values are:

l 3 (default)

l 2 (for old versions of LDAP)

baseDistinguishNameDelimiter Base DN delimiter. Symbol used in configuration when putting

HP Enterprise Collaboration (1.1)Page 72 of 73

Installation and Configuration Guide
Appendix B: Updating the external-ldap.properties File



Attribute Description

multiple base DNs for users or groups or users search. Note
that this symbol must not appear as part of the base DN used
in this configuration. If it appears in the base DNs, change the
default value to some other symbol.

scopeDelimiter Scope delimiter. Symbol used in configuration when putting
multiple scopes for users or groups search. This symbol must
not appear as part of the scope name used in this
configuration. If it appears in the scope name, change the
default value to some other symbol.

attributeValuesDelimiter Symbol used in configuration when putting in multiple attribute
names of users or group. Pay attention that this symbol must
not appear as part of attributes used in this configuration. If it
appears in attribute names, then change the default value to
some other symbol.

Logging into LDAP using the Apache Directory Studio LDAP
Browser

This section explains how to log into LDAP using the Apache Directory Studio LDAP Browser.

To connect to the LDAP server, perform the following steps:

1. Download and Install the Apache Directory Studio LDAP browser from:

http://directory.apache.org/studio/

2. Open the LDAP browser and select the New Connection button from the Connections tab
located in the bottom left side of the application window.

3. Enter the LDAP Host name (ldapHost) and Port number (ldapPort).

4. Select the appropriate encryption level (enableSSL).

5. Click theCheck Network Parameters button.

6. Click theNext button.

7. Select one of the following Authenticationmethods:

n NoAuthentication: useAdministrator=false

n Simple Authentication: useAdministrator=true

8. Click the Finish button (this automatically tests the connection).
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